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1. Overview

IPMIView (IPMI-Over-LAN) is a management software program based on the IPMI
specification Reversion 1.5 - 2.0. IPMIView sends IPMI messages to and from the
BMC (Base Management Card) on a host system at a remote location. IPMI

messages are encapsulated in the RMCP (Remote Management Control Protocol)

packets called “datagrams.” This method is also referred to as “IPMI-over-LAN.”

According to the Distributed Management Task Force (DMTF) Specification, RMCP
is used for system management in a pre-OS or an OS-absent environment. RMCP is
a simple request-response protocol that can be delivered using the UDP (User
Datagram Protocol) datagrams. IPMI-over-LAN uses version 1 of the RMCP protocol
and packet format. An RMCP packet is transmitted via an IP (Internet Protocol)
networking, which will allow system managers to manage their IPMI-enabled systems
over the Internet. In a private LAN network, this is a basic feature. IPMI uses the
same UDP port number (623 in decimal) as the ASF (Alert Standard Forum) protocol.
If the managed system is protected by a firewall, UDP port 623 must be opened.

In Supermicro’s IPMI solution, a BMC (Baseboard Management Controller) shares
the LAN1 NIC on the mainboard. (If there are more than one LAN Ports on the
mainboard, LANL1 is the one closest to the Keyboard/Mouse Port.) The NIC will re-
route the IPMI packet to the BMC instead of forwarding it to the upper layer of the

network protocol stacks as other protocol packets do.

IPMIView V2.0 covers Supermicro’s BMCs for both IPMI v1.5 and IPMI v2.0.
However, due to design changes, some functions may not be available for IPMI v1.5,
while others, might no longer be available for IPMI v2.0. IPMIView will automatically
hide any functions that are not available based on the BMC version used in the

system.
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2. System Management
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Figure 2-1

¢ Menu Bar: contains functions that allow you to add/delete systems or groups
and save configurations.

e Toolbar: contains functions that allow you to execute commands quickly. Click
the icons on the toolbar to add a new system, save the current configuration
settings, to discover IPMI devices, to access group management, to discontinue
the IPMIView section and to access the help menus. See Figure 2-2 for details.

e Logo: Click the Logo icon to visit Supermicro’s website.

e |PMI Sorting: This allows you to sort devices in an ascending/descending order
via the online format, or in the original sequence.

e System List: This lists the computers managed by the BMC Controller.

¢ Group Management: This allows the user to manage system groups, including
creating/adding new accounts, deleting accounts and update group information.

e Group List: It lists computer groups managed by the BMC for better

management.
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e Viewing Window: This shows detailed information including Login, IPMI Device,
Event Log, Sensors, BMC Settings, and the status of the IPMIView firmware.

e System View Sessions: IPMIView can manage up to 20 systems at any given
time. The systems that are currently managed by the BMC are indicated in the
System View window.

e Bottom Toolbar: This toolbar contains function tabs that allow you to execute
commands quickly. The tabs allow you to access the following submenus: Login,

Event Log, Sensors, IPMI Device, BMC Setting, Users, Text Console, KVM
Console.

As shown in Figure 2-1, there are several components in the IPMIView window
(Figure 2-2):

U7 IPMI Ficw ¥2.6.20 (build 070927) - Super Micro Computer, Tnc.
Eile Edit Mansge Help

iEagEs @R
SUPERMICR®

AwQEH

IPMI Domain

Ll 192.168.10.241
=] 193.168.10.242
Il 192.168.10.243

IPMI View

Intelligent Platform Management Interface

IPMI 2.0/1.5 over LAN

Feady

Figure 2-2

e ToolBar (Top)
The toolbar provides you with direct access to the features that are used frequently
(as shown in Figure 2-3). You are able to switch between server- and group-
management. The following toolbar shows the items that are currently available for
user configuration under the BMC management.
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Add a new System
Save configuration
Discover IPMI device
Switch to server management

Switch to group management

Al A 0Ee Qe
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About

Figure 2-3

¢ Adding a new system
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Figure 2-4

Click <File>"New>System” to add a new system to the IPMI connection (as shown
in Figure 2-4). An “Add a new system...” dialog box will display as shown in Figure
2-5.
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Z Add a new system. El |El g|

System Mame:

IP address: | 0.0.0.0 |

Description: | DESCRIPTION |

Figure 2-5

In the “Add a new system” dialog box, enter the System Name for the system to be

managed by the BMC, its IP address, and its description. Then click <OK>.

e Adding anew group
For better system management, the manager may group systems in different groups.
A system may be included in multiple groups. The default group is the “IPMI
Domain.” All systems under the BMC management belong to the IPMI Domain even

if they are also grouped into other groups.

Click the menu: <File>"New...>Group” to add a new group to the IPMI connection.

An “Add a new group” dialog box will display as shown in Figure 2-6.

i Add anew Zronp El |El [5__<|

Group Marne:

Description: | CESCRIPTION |

Figure 2-6

In the “Add a new group” dialog box, enter the Group Name and its description.
Then click <OK.>
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o Discover IPMI Device

IPMIView offers a feature that will detect all devices or systems currently connected
to the network. The user may specify a Network IP address range, and the network

Mask, then click <Detect> or <Start> to search any IPMI devices or systems that are
connected to the IPMI 1.5 or IPMI 2.0 connections as shown in Figure 2-7. Click

<Exit> to discontinue this process.

& TPMI Device Discovering

Metwork P From | [ERETRDKS

To | 192.165.10.254

Metwork Mask | 255 255 255 0

Search Option

IPMI20 [C]IPMINS

Start Exit

Found: 2

P Mame “ersion
19216510241 [192168.10.241 P 2.0+ |
182.168.10.246 [102.168.10.296 Pt 2.0 |

Figure 2-7

¢ Reload Configuration
From the pull-down menu, click <File>"Reload Configuration” to load the

configuration settings that were previously saved.

e Save Configuration
From the pull-down menu, click <File> “Save Configuration” to save the current

configuration settings.

e Update Firmware

From the pull-down menu, click <File> “Update Firmware,” and select the system you
wish to update from the IPMI Domain list on the left side of the window. A
Confirmation dialogue box will appear. Click <OK> to update the IPMI Firmware.

Click <Cancel> to discontinue this process.

From the pull-down menu, click “File>Save Configuration” to save the current

IPMIView configuration settings.
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e Language
From the pull-down menu, click <File> “Language” to activate a Language submenu.
From the submenu, you can select Chinese (Taiwan), Chinese (China) or English

(USA) as your IPMI language setting.

e Exit

From the pull-down menu, click <File> “Exit” or press <Alt-F4> to exit IPMIView.

¢ Modify System
Select a system in the System Window you want to modify and click <Edit> “Modify

System” to maodify it from the pull-down menu as shown in Figure 2-8.

You can also right click on a system in the System Window and select “Modify” in the

pop-up menu to modify it.

e Modify Group
Select a group in the Group Window you want to modify and click

“Edit>Modify...>Group” from the pull-down menu shown in Figure 2-8 to modify it.

You can also right click a group in the Group Window and select "Modify” in the pop-
up menu to modify it.
Fils Session  Manage Help

Modify ' o | e _
D ey e 2 ©

S IPMI Secnrity Gromp || 2 102.168.10:

Join ll._/ K.
Dl ~oE®

Al 192.168.10.243

Figure 2-8

o Delete System
Select a system in the System Window you want to delete and click <Edit> "Delete

System” from the pull-down menu as shown in Figure 2-8 to delete it.
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You can also right click on a system in the System Window, and select “Delete” in the

pop-up menu to delete it.

o Delete Group
Select a group in the System Window you want to delete and click <Edit> "Delete

Group” from the pull-down menu to delete it as shown in Figure 2-8.

You can also right click a group in the System Window, and select “Delete” in the

pop-up menu to delete it.

o IPMI Security

From the pull-down menu, click <Edit>"IPMI Security” to activate the IPMI Security
dialogue box. Check Auto Detection for IPMIView to automatically check the current
IPMI status. Check the Advanced User box to select the following protocols as shown

in Figure 2-9.

* Hardware: BMCB, Firmware:IPMI 1.5:
* Hardware: BMC2, Firmware:IPMI 2.0 (non-RMCP+):
* Hardware: BMC2, Firmware:IPMI 2.0 (Standard RMCP+).

Check the Encryption box to use encryption supported by the IPMI 2.0 Standard
RMCP+. All packets transmitted from IPMIView to the BMC system management will

be encrypted.

IPhI Protocol =

P IFMI Pratocal for Mew Syatem :

‘_H_t

() Auta Detection
For Advanced User. Select Following Protocols based on Hw and P
() Hw! : BMCE, P! : IPMI1.5
) Ht - BMC2, PV PR 2.0 non-RMCP+
(&) Hw/ . BMC2, Fw': IPMI 2.0 Standard RMCP+
Enciypliari
Hw/ = Hardware
P/ = Firmuvare

Figure 2-9
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e Joinagroup
Select a group in the Group window, a system in the System Window, and click <Edit
“Join” from the pull-down menu to include (to join) this system into the group as

shown in Figure 2-8.

e Disjoin a System or a Group

Double click the group from which you want to disjoin a system. The systems that are
included in the group will appear in the System Window. Then, select the system you
want to disjoin from the group, and click <Edit> “Disjoin” from the pull-down menu
shown in Figure 2-8. You can also select a group from the Groups list and click

<Edit> “Disjoin” to remove it from the IPMI groups.

You can also right click the selected system, and select “Disjoin” in the pop-up menu

to remove it from the group.

e Refresh

Double click the group from which you want to disjoin a system. The systems that are
included in the group will appear in the System Window. Select the system you want
to refresh, and click <Edit> “Refresh” from the pull-down menu to refresh the system

as shown in Figure 2-8.

e Timeout

The timeout setting is shown in Figure 2-10. Timeout is the period for IPMIView to
wait for a response after sending a command to a managed system. If a response is
not received from the managed system in the timeout period, IPMIView will resend
the command to managed system again. You may specify the timeout value (in
seconds) to get a quicker response from the managed system. You can also specify
the number of times that IPMIView will resend the command.

b ] Timneout for retry [zecond] 8
2
g Mumber of rety 20
ok Zancel
Figure 2-10
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e Section
IPMIView will display the IP address(es) currently connected to the network when

you click <Section> from the toolbar. You can disconnect the IPMI connection from a

Bl B @5 ke

Group

Setting...

SUFErVIICR®

M IPMI Domain = A % T £ 4
=) Mew Systeml |
EJI 192.168.1.227

L=} Mew System?2

::J‘ 1592.168.1.168

& 152168.1.38

1PMI View

Intelligent Platform Management Interface

IPMI 2.0/1.5 over LAN

"' | IPMI Domain [1/5)

Figure 2-11

¢ IPMIView Management
IPMIView allows you to manage your server or your network group by selecting

<Manage> “Server/Group” from the pull-down menu as shown in Figure 2-11.

In addition, you can also configure Group Login Settings by selecting “Setting” from a
pull-down menu under the <Manage> tab. A dialog box will appear, prompting you for
the Login ID and Password. Once enter the values in these fields, click <OK> to
access the page and configure the settings. Please note that this feature is available

for the system administrator only.

e Help

Select <About> to display the information on the systems connected to the network.

10
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3. Login

e Login

Click the <Login> tab on the bottom toolbar as shown in Figure 3-1. A login screen
along with some information about the managed system will appear in the Viewing
Window. Enter the login ID and password, and click the <Login> button to log in.
When login is successful, the connection information will be shown at the bottom.
The Login button is grayed (disabled), and the Logout button as well as other

available management functions will be enabled. as shown in Figure 3-2.

Fin Fdt Sewion Masge Help
Ol a8l @ RO k
| CSCCTE]
SUPERMICR®
PMiDomain & v QB &
St St RS
=) Hew Syatmal 1P andess 192168038
(=) Hew Symtend
) Hem Sysiomd Deserpion GESCRIPTION
News Systet
(=) Hew Syatant
LegniD | ADMIN
Passwen) | ====
2] tarve 10 ond Password
Logn
s Bade
Lagn
Feady
Figure 3-1
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nE e Qe e
SUPERMICR® 1=~ "

PMiDomen & v 0 8 %
System Hame 192168 10241

192.168.10 242
L 19216010 243
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Dexcepon 19216010241

LogaID | ADMIN

[] e £D) amd Pasmennd

——— — CONNECTED
Groups CEXES
IPMI Domatn (£04)

Vermom © 1FM1 20 RMCF

Crphet Dt RAKP-HMAC-JHAL, HMAC-THAL-96, AES-CBC-125

Login | EventLog | Sensoct | [FM Dévice | BMC Setting | Doert | Teat Console | KVM Console | Victoal Medas

RMC T Open Session reccersful

Figure 3-2
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The default Login ID and password are “ADMIN”. Both are case-sensitive.

In IPMIView, an MD5 algorithm will encrypt the password when it is transmitted
through the network. (If you are connecting to the IPMI 2.0 RMCP+, all the data will
be transmitted by an encrypted algorithm.) Once the password is confirmed,
IPMIView will show a CONNECTED symbol, and all available function pages will be
shown as in Figure 3-2. If the password is invalid, a message will be displayed in the
Status Area that reads, “Unable to activate a session, please check ID and

Password.” and a Break symbol will be shown (see Figure 3-3).

:j IPMI Yiew ¥2.6.20 (build 070927) - Super Micro Computer, Inc.
File Edit Session Mansge Help

Bl & ||I'_E| S 2
SUPERMICR® |~ ="

IPMIDomain =~ 4w G £ @

Bystemn Name 10216810241

IF Address 19216810241

Description 192 168.10 241

LoginID | admin

Password

save 1D and Pazmword

Login

BREAK
55| Groups B&de
[l [FMI Dormsin i444)
Login
RAKP Message 2 error: Unavthorized name (status code = 0Dh)
Figure 3-3

In order to reduce overhead on the managed system, all pages will not be refreshed

automatically. The user must refresh the pages manually as needed.

After logging in, the IPMIView main window will display as shown in Figure 3-2. A tool

bar will display on the bottom of the screen for your convenience.

12
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e Bottom ToolBar
As shown in Figure 2-4 below, this toolbar contains function tabs to allow you to
execute commands quickly. The tabs allow you to access the following submenus:
Login, Event Log, Sensors, IPMI Device, BMC Setting, Users, Text Console, KVM
Console.

Log

Event Log
Sensors

IPMI Device BMC Setting

Login | Event Log| Sensors|| IPM Device | BMC Setting|| Users | Test Console | KM Consalel

Users

Text Console
KVM Console

Figure 3-4

13
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4. Event Log

After you have logged into a system, the screen as shown in Figure 4-1 will display.

Click the <Event Log> tab on the bottom toolbar to activate the Event Log screen as
shown in Figure 4-2.

DT IPMI View ¥2.6.29 (bnild 0927 - Snper Micrn Computer, Ine

File Bdit Serca Mansge lal
@ e Bl 2@
SUP]:RM[CR. 1 I 19 16800291
B MiDoman A v § 2 @
LG SA0 Systern Buim 192 166.10:291
192.1660,10.242
192 166.10.343 TP Addre 192 16810 241
Dewaphan 19216810211
LoginlD | ADMIK
L
] e 10 Pl
[
— CONNECTED
Groups B&& e
TEMI Domsnn, (14)
Fersion + TFMI 20 RMCP
Cigher Suite - RAKP-HMAC SHA1, HMAC-SHA1 06, ABS CEC- 178
Login | Event Loy | Seisrs | 1PH Devace | BHC Saltug | Usmis]| Tand Comule | KV Comole | Vel Melss
RMCP+ Open Sean saersalel

Figure 4-1

File Edit Session Manage Help
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System Event Log

Export Ertries

SEL Version: 1.5

|| News Syatem3 @ Al !

= Tatal Eny

) 192.168.1.168 ) - otal Entries: 171

) New System? ) From 1 | To 171 | Fiee Space: 6820 bytes

) 1921681227

Fiecent Entry Added:  12/08/2009 16:44:49 Tue
EJJ Mew System [ Get ] I Export ]

Recent Entry Erased: 010141970 00:00:00 Thu

Clear & Entries

E&de :
e il Current SEL Device Timestamp: | 12/09/2009 14:44:28 Wed CaTimasan
irLogiHI I o |VSensors || IPMl Device || BMC Setting | Users|| Text Console| KM Console|

Giet SEL Time succeeded

Figure 4-2
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System Event Log

All: Click this radio button to select all events.

From...to: Click this radio box to select a portion of events.

Get: Click this tab to get the event logs.

Export: Click this tab to export event logs to a file.

Clear All Entries: Click this tab to clear all event log entries.

Current SEL Device Timestamp: This item displays the timestamp of the

current SEL device.

Set Timestamp: Click this tab to set the timestamp for the system selected.

Refresh: Click this tab to refresh this page.

15
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5. Sensors

This feature displays the status of each sensor used to monitor system health as

shown in Figure 5-1.

Ph e 0 (b d 09 1 per k o Compute el

File Edit Session Manage Help

bl agome 9 e
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Temperatures

=5 Groups &

[T IPMI Diomain [1/6)

Hide inactive item
[] Shaw Histary

Fiefreshevery (B0 v | seconds | Refiesh Now ]‘[ SaveLayout_|

[ Login|| Event Log| Sensors | IPM Device | BMC Setting]| Users|[ Text Console | KvM Consle|

FRiefreshing sensors' status completed

Figure 5-1

¢ Fans: This window displays fan status.

¢ Voltages: This window displays voltage readings for various devices.

e Temperatures: This window displays temperature readings for various devices.

e Sensors: This window displays the devices being monitored.

e Refresh Every X seconds: Enter the number of seconds for the system to
refresh.

e Refresh Now: Click this tab to refresh the Sensors page immediately.

e Save Layout: Click this tab to save the current layout setting.

e Hide inactive item: Check this box to hide inactive items.

e Show History: Check this box to display the sensor records.

16
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6. IPM Devices

Click the IPM Device tab of the IPMIView management session in the Viewing

Window (shown in Figure 6-1) to display the information and functionality of the BMC

firmware installed in the system.

File Edit Session Manage Help

fEAOE QRO N

S C . = 132168138
i IPMI Domain P @ Devin:e.lmnrmat\nn )
!g 192.168.1.38 Firmware Revision 09.99 ACP! Syster Power State S0/G0 I
) New System3 IPMI Revision 2.0 0

) 192.168.1.168
=) Mew System2
) 1921881 227 Graceful Power Control
| ) New System1

On
REjFziEait Sl e e

Chassis Powwer Control

L owernliown N__Powerp N Powerycle N JREsel |

BMC uiD LED

[ codpest | Blink LID LED

Groups EEE

{7 IPMI Domain [1/8)

Lung [ Event Lug: 5‘ensurs:5__|E_M_ .D.‘?.V.‘.‘?P.E: BMC SE"I}.]g. Users|| Text Console|| K¥M Conscle|

Gt ACPI Power State succeeded

Figure 6-1

e Device Information

This shows the revision levels of the BMC and IPMI firmware.

e ACPI System Power State
This shows the power state of the managed system. If the managed system is in a
power-off state, the green light will be off. It will be updated automatically every five

seconds.

o Graceful Power Control (Administrator and Operator only)
Graceful shutdown will inform the OS running on the managed system to

shutdown within a specified time. When the OS running on the managed

system receives a graceful shutdown request, it will start to shutdown system.

This behavior is via ACPI by emulating a fatal over temperature.

17
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e Graceful Shutdown: This feature has the same function as “shutdown” in the

Windows. Using this feature will cause the managed system to enter the S5 state.

e Power On Icon: Click on the Power-On icon to power on or power off the device.

e Chassis Power Control (Available for the Administrator and Operator only)
This feature is used to manually control the power state of the chassis of a managed
system. When the BMC receives the power control command from the chassis, it will

have direct control over the power button or the reset button of a system.

e Power Down: This feature will power off a managed system as it would when the

Power-Down button of the chassis is pressed.

e Power Up: This feature will turn on the power of a managed system as it would

when the Power-Up button of the chassis is pressed.

e Power Cycle: This feature will turn off the power of a managed system for a few

seconds and then turn on the power of the system again.

¢ Reset: This feature resets a managed system as it would when the Reset button

of the chassis is pressed.

e BMC Cold Reset (for the Administrator only)

Clicking the Cold Reset button allows you to reset the BMC. After confirming the
reset of the BMC, the session will be terminated immediately. The user has to close
this session manually. This feature is rarely used. It is only used for an event when

you suspect a system malfunction for example.
e UID (Unit Identifier) LED
* Blink UID LED: Click this table for the UID LED to blink when the unit in

guestion is identified.

e Refresh

Click this tab to refresh this page.

18
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/. BMC Settings

(Available for the Administrator only)

Click the BMC Setting tab of the IPMIView management session in the Viewing
Window (as shown in Figure 7-1) to display detailed information on the BMC LAN

Configuration, SNMP trap configuration and the serial port status.

BMC LAN Configuration
i [T ] s | o]
Subnet Mask l:l LAN MAC must be correct while npdate
=T T
SNMP
—
SNMP Trap Receivers IP Lddress
0.0.0.0 ~
0.0.0.0
0.0.0.0
0.0.0.0
0.0.0.0 2
L AN Interface
) Dedicated () On Boaxd LAN @) Failover
Login | EventLog || Sensors | [PM Device || B Set‘lmg| Tsers | Tewt Comsols | KVM Console

Figure 7-1

¢ BMC LAN Configuration

This feature displays the IP address, the LAN MAC, the Gateway IP, the Gateway
MAC and the Subnet Mask of the BMC and allows you to modify these settings.
NOTE: please make sure that the MAC address of the LAN and the gateway for the
BMC are correct before updating it by clicking the <Update> button. Be careful to
enter the correct values especially for the LAN MAC. If you enter the wrong LAN

MAC, IPMIView will not be able to connect to that system any more.

19
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If you accidentally enter a wrong LAN MAC value, you may use the IPnMAC.exe
command in the IPMI Solution/Utility subfolder on this CD to update it. To activate
IPNMAC.exe.,which is a DOS command, you must first boot your managed system to
DOS, and then execute IPNMAC.exe on the managed system. You can also enable
the VLAN (Virtual LAN) Tag setting by clicking on the “Enable VLAN Tagging” box on
the right and enter the value on the VLAN Tag field to configure VLAN Tag setting.

e SNMP

This displays the SNMP trap configuration of the system that needs to receive the

SNMP traps generated by the BMC to allow you to modify the settings. To change

the configuration on the BMC, enter the SNMP community name in the Community
text field, and enter the IP address as well as the MAC address in the SNMP Trap

Receivers table in the SNMP group. Then, click the <Update> button.

The SNMP Trap may have multiple destinations. When any critical error occurs, an
SNMP trap packet will be sent to all receivers in the list. To remove an SNMP
receiver, you may change both IP and MAC addresses to 0.0.0.0 and
00:00:00:00:00:00 respectively. Then, click <Update>.

For a system to receive the SNMP traps, you must install and run an SNMP trap
receiver program. The managed system will send out an SNMP trap packet to all
receivers when an event occurs. If an SNMP trap receiver is not running, the trap

packet is discarded, and cannot be queued anywhere.

e RS232/ MODEM (available for IPMI 1.5 only)
This displays the configuration of the RS232 interface on the BMC. It is used to
initialize the RS232 port and the installed modem, if any. The RS232 port is the box-
header (Figure 7-2) on the BMC, and a dedicated serial port.
* Baud Rate: It is the baud rate for serial connections, which will not affect
paging settings.
* Modem Init String: This is the modem initialization string for serial link

connections, which will not affect paging settings.
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Figure 7-2

LAN Interface

Dedicated: Click this radio box to use the IPMI-Dedicated LAN as the default
LAN connection.

Onboard LAN1: Click this radio box to use the onboard LAN port 1 as the
default LAN connection.

Failover: Click this radio box to enable Failover support.

Update: Click this tab to update LAN connection status.

Refresh: Click this tab to refresh the page.
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3. Users
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Figure 8-1 (For IPMI 2.0)
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Figure 8-2 (For IPMI 1.5)
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Click the Users tab of the IPMIView management session in the Viewing Window (as

shown in Figure 8-1 and 8-2) to display detailed information on the Users

management, and paging severity thresholds for IPMI 1.5.

We strongly recommend that you change the password immediately for

security reasons.

USERS
* User Name
IPMIView allows you to add or delete a user, to change a user’s password, to set

and update user privilege settings by clicking the appropriate tabs.

* Privilege

This feature allows you to set and update privilege level for a user or delete a
user from the list. There are six privilege levels, Callback, User, Operator,
Administrator, OEM, and No Access. Only the first four privileges are supported.
Privilege Levels determine which IPMI commands a user can execute over a
channel. Privilege Limits set the maximum privilege level that a user is allowed to
operate at. A user is granted certain privileges for each channel, and the user can

operate at a privilege level that is granted. Click the “Update Privilege” to change

the privilege level setting for a user.

Group Privilege Levels

Callback

This may be the lowest privilege level. Only those commands that
are used to initiate a Callback are allowed. (Available for IPMI 1.5

only.)

User

Only the basic commands are allowed. These commands are used
to read and retrieve data, to modify BMC configuration settings, or to
write data to the BMC or other controllers. Actions such as resets,
power on/off, and watchdog activation are not allowed.

Operator

All BMC commands are allowed, except for commands that can
modify out-of-band interface settings. For example, the Operator is
not allowed to disable individual channels or change a user’s access
privileges.

Administrator

All BMC commands are allowed, including modifying commands. An
Administrator is allowed to execute configuration commands that
disables the channel over which the Administrator is communicating.
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e SOL (Serial-Over-LAN)
This feature allows the user to configure SOL settings. Click “Enable” to
enable SOL support. Click “Update SOL Privilege” to update a user’'s SOL

privilege level.

Click Paging Setting to set the parameters for an individual user (Figure 8-3).
There are two types of paging services: Numeric paging and alphanumeric
paging. To use a paging service, a modem must be connected to the RS232

connector on the BMC (Figure 7-2).

& Paging Setting

User Mame oo

Pager hade

Paging Service Mumber 09125805132

Mumeric Meszage | Sooeg#

Modetn Init String | ATLAKA X 358=2E

Dial String | &TDT

Upidate ” Cancel ” Test Paging

Figure 8-3

e FRU (for IPMI 2.0 only)

This provides useful information on the board and the product, including the serial
number, part number, and the components of the motherboard. Click the “Update
FRU” tab to update board information and product information, including information
on the manufacturer, the name of firmware, the serial number/ the part number of the
motherboard, and the part/model number of the BMC firmware, the version and the
serial of the IPMI/BMC firmware.
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e PAGING/SEVERITY (for IPMI 1.5 only)
Use paging severity settings to determine when a user will be notified of an entry of

the system event log (SEL).

The following settings are available for each group:

None When this setting is selected, user notification for this group is disabled.

Warning When this setting is selected, the RMC will notify the user when SEL

entries for the group exceed the warning thresholds.

Critical When this setting is selected, the RMC will notify the user when SEL

entries for the group exceed the critical thresholds.

All When this is selected, the RMC will notify the user of all entries of the

SEL events for the group.

All warning and critical thresholds are predefined by Supermicro based on hardware

design.
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9. Text Console Redirection

(SOL- Se
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Get ACP| Power State succeeded

Figure 9-1

Click the <Text Console> tab on the bottom tool box (shown in Figure 9-1) to enable

Text Console Redirection support, which will allow you to control a remote system

from a text mode console. Click the <Start> button to start the text console

redirection. Click the <Stop> button to stop the text console.

® BMC for IPMI 1.5

Console Redirection is not supported by the IPMI specification V1.5. Supermicro

provides this useful feature for a manager to control the managed system from a

remote location. When a managed system is booting up during the POST routine,

and no other software application are available for you so that you can gain control
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over console redirection, IPMIView provides you with this valuable feature. Console
Redirection will redirect the monitor of a managed system for IPMIView use and

allows you to send the key codes to the managed system.

When a managed system changes its video mode from Text Mode to Graphics Mode,
a termination notice will be sent to IPMIView to terminate the console redirection.

Text Console Redirection only works with the text mode.

Important Note: Console Redirection can cast a very heavy load on a managed
system. It will redirect the whole monitor to the manager’s system, and it will slow
down the managed system significantly. We suggest that you use this function only
when you absolutely need it. For other applications, a proper console redirection
software application (pcAnywhere, Symantec Corporation) or a remote login protocol
(telnet) is recommended. When you finish your remote operation, click <Stop> to

terminate console redirection to take the load off the managed system.

® BMC for IPMI 2.0

Serial-Over-LAN (SOL) was designed to support Text Console Redirection based on
the IPMI specification V2.0. This function performs better in IPMI 2.0 than in IPMI 1.5.
The Text mode console is supported by the Windows 2003, even when the OS is
running. To support Text Console Redirection on the Windows 2003, Special
Administration Console (SAC) must be enabled. The following instructions are used
to enable the SAC:

1. Enable Console Redirection in the BIOS, and set it to COM 2 (or COM B)

2. Modify boot.ini in C:\. Boot.ini is a hidden file. An example of boot.ini is listed

below.

[boot loader]

redirect=com2

redirectbaudrate=19200

timeout=30

default=multi(0)disk(0)rdisk(0)partition(L)\WINDOWS

[operating systems]

multi(0)disk(0)rdisk(0)partition(1)\WINDOWS="Windows Server 2003, Standard"
[fastdetect /redirect
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To enable Text Console Redirection support on a Linux Platform:
1. Host A with the IPMI BMC installed (for the Linux Platform):

a) BIOS POST:
(i) Enable "Console Redirection™" in BIOS Setup.
For example, COM2 / 19.2Kbps / 8N1

(ii) Disable "Enable Console Redirection after POST" in the BIOS setup.

b) Boot Loader:
() For GRUB,
add the following TWO lines into /boot/grub/grub.conf, but
comment out "splashimage=(hd0,0)/grub/splash.xpm.gz"
serial --unit=1 --speed=19200 --word=8 --parity=no --stop=1
terminal --timeout=10 serial console
#splashimage=(hd0,0)/grub/splash.xpm.gz

(i) Then add "serial console=ttyS1,19200n8" to the end of kernel /vmlinuz in

/boot/grub/grub.conf.

For example:
kernel /vmlinuz-2.6.5-1.358smp ro root=LABEL=/ rhgb quiet serial

console=ttyS1,19200n8
This will result in all boot messages being output to the console ttyS1, but

you will not see
All these boot messages on the local console until the login message

prompts.

¢) LINUX OS:

(i) Add the following line into /etc/inittab.
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s0:2345:respawn:/sbhin/agetty ttyS1 19200
(i) Edit /etc/securetty and add ttyS1
2. Host B with IPMIView installed:
a) Install and run IPMIView.
b) Log in Host A with the IPMI BMC installed as Admin.
c) Start Console Redirection in IPMIView immediately after the Host A

reboots.

You will see the BIOS POST, the boot loader, and the Linux OS messages

and prompts.
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10. KVM Console (KVM-Over-IP

for Video Redirection)

KVM Console Redirection is a new feature included in the Supermicro Intelligent
Management (SIM) Module. If Video Console Redirection support is enabled, the
remote screen will be redirected to IPMIView. BIOS POST, BIOS settings, DOS,

Windows or Linux OS screens can all be redirected to IPMIView.
Click the <Launch KVM Console> tab to launch KVM console redirection.
Figure 10-1 shows sample screenshots of Video Console redirection. The screen of a

remote managed system will be redirected to IPMIView. You will see the screen of

the remote system just as if you were sitting in front of the system.

U7 IPMI ¥iew ¥2.5 Beta{build 060522) - Super Micro Computer, Ing.
File Edit Session Manage Help

V| = 921681024

SUPERMICR®
. =) @® & [100% -] E st E]‘El Options
P

iGroup: Detabase Cluster

192.168.10.241
192.168.10.242

1] 152.165.10.24

System Boot Up

www.superm icro.com

= MM IPMI Dornain
Eg Elade Certer

Conzole(Morm): Desktop size is 640 x 480 Fps: 01n: 0 B/s Out: 0 Bis

Login || Evert Log || Sensors | IPM Device | BMC Setting | Users | Text Console | video Console

Wideno Interface loaded

Figure 10-1-1
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Toolbar

There are several tool buttons that can be used for video console as shown in Figure

10-2.
Zoom In
Select Percentage for Scaling Screen
Zoom Out
Send Ctrl+Alt+Del to Remote

Auto Adjust Screen
| =) 192168.10.249 |
E 0 ] [ﬁ @, [100% «| & ctrisateDel g Opﬁ]ons
O|pen or Close Quick Shot Panel Options

Quick Shot
Screen Capture

Full Screen

Stop Video Redirection
Start Video Redirection
Figure 10-2 Video Console Toolbar

@ Start Video Redirection:
This button is used to start video redirection. IPMIView will automatically start the

video redirection when you click the Video console tab.
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. Stop Video Redirection:
This button is used to stop video redirection. To stop video redirection, press this
button again to stop it. Please note that the drive redirection will continue to work

when it is enabled.

r@ Full Screen:
This button is used to maximize the size of the remote video screen on the local
computer display. You may press <alt + enter> to return to the original mode. Please

refer to Figure 10-3.

CTIPMI Vaew V2.5 Betn(huibd DGUSE) - Super Mien Compuler, lae

& i il‘ﬁ' 16024

IPERMIC
SUPERMICR® |,'g 5 g @ & fon =& owees GBI oms

|| L supermic putsr, inc. Home Page - Konausror 8
19218810242 Lotation Lot yiew Go [ookmans loals Settings Window el
| - . 1 & _—
l2cad 0w « Do fRG 8

© Lacation: | [{8 rite e supeimicis com

SUPERMICR® o 1 Coatact Ut

e Mew Dempseay Server Solutions . New Dérl;lpany -]
Supermicro offers 204
Supemiicro ks st 10 offer he most i SKUs - AVAILABLE
NN SusiiEhle RO R =
Lt ¥
| foxdomanammoe e 1 (O
|Logn | Evert Log | Senors | PM Device | BMC Setting | Users | Texd Console | video Conscle: _1
s e bt |
I Alt + Enter
L supsrmicro Computer, Ine. Home Page - Kenaveror B o L e
Lecation fdt Yiew Go Bookmarks Tools Fettings Window Heip
QA O « o ARS8
B tacation: | [[B R waw supermicrs comy
PERMICR®" TN e - ]

St Crincal

_ﬁ:ﬁ "S‘bﬁuirms

Naw Featured Motherboards
New Dempsey Serverboards |

Supermicro offers 20+ Serverboard
SKU's - AVAILABLE TODAY!

Figure 10-3
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Screen Capture:
This button is used to capture the screenshots of the remote managed systems. You

will see a file-save dialog box with a preview image. Select the directory and filename

to save it. The file format can be PNG or JPG.

E21 ouick shot:

This button is used to capture quick screenshots. You will need to first specify a
directory where you want to store quick shot images. You will see the quick shot

images in the quick shot panel. Please refer to Figure 10-4.
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Figure 10-4

Open or Close a Quick Shot Panel:
This button is a switch used for opening or closing the quick shot panel. Double click

the image in this panel to show a full-size window for viewing.

@% Zoom In:

This button is used for zooming in the screen (up to 300%). Please refer to Figure

10-5.
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Figure 10-5

®§ Zoom Out:
This button is used for zooming out. The maximum zoom out percentage is 10%.

Please refer to Figure 10-6.
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Figure 10-6

[100%  ~| select percentage for Scaling Screen:
This combo box allows you to select the setting of screen scaling, either 10%, 25%,

50%, 75%, 100%, 200%, 250% or 300%. An additional selection allows you to scale

to fit with the IPMIView window size.

Cri+AtDEl Send Ctrl + Alt + Del to Remote:
This button is used to send the <Ctrl + Alt + Del key >combination to the remote
system. It is useful when the remote system is running in the BIOS, DOS or Windows

environment.
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@ Auto Adjust Screen:

This button is used to adjust the screen automatically. Press this button if it's difficult

for you to see the whole screen.

Options

Options:

You can select more options here. The list of options is listed below.

Monitor Only: Use this feature to display the remote screen only. The keyboard
and mouse will be disabled.
Readability Filter: This item uses algorithm to improve screen display. This will
allow you to see the text content easier when you scale the screen.
Local Cursor: Use this to change local cursor settings.
Chat Window: This feature allows the user to chat with each other via the IPMI
connection. Please refer to Figure 10-7.

07192.168.10.24 Chat 3

im@IEM-DOCE4 107030 super }== test
root@l inux{super )=+ 456

jim@IBM-DDCE4107030(super) | [~ Beep

Figure 10-7 Chat Window

Video Settings: This feature allows you to configure the advanced video settings.

Please refer to Figure 10-8.

1] ¥ideo Settings X

Brightness  +| ] | 70
ConfrastRed | i | 114
Contrast Green 4 | Il | 110
ConfrastBlue  _« | Il | 112
Clock | ] | 1344
Phase | I 29
Horizontal Offset + | I | 308
Verical Offset | | | 34
é"ii'é'é'é'i"i'r'i'i'é'"r'&i'&'&é“é| Reset All Modes |
Save Changes | 1,024x768 60Hz Undo Changes

Figure 10-8 Video Settings

Refresh Video: This feature allows you to refresh the video screen.
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* Soft Keyboard: A virtual keyboard is provided for easy input. It also provides
localized keyboard mapping. Please refer to Figure 10-9.

English (United States) L04pc X
Ess  F1|F2|F3|F4/F5|FE|FTIFEFIFI0F11F1Z Frn & | Brk
1zl 24la6| 7890 =—In~ L&
"_;qwertyuiop[]doe|&dI'\1‘I+
Llals|d{flafh]jlklI];1"|M |5~
DV zfxle | v|blnim|, .7 & +| Bed 4| T
Ctrl | St|ai att |[sthe om [«[+]=+[ ins De/*

Figure 10-9 Soft Keyboard

* Local Keyboard: This feature allows you to set local keyboard mapping settings.
* Encoding: This feature supports encoding for the video screen. The options for
encoding are “Predefined”, “Compression” and “Color Depth”.

Status Bar

Figure 10-10 displays the status bar for the video redirection.

Message Frames per second and In/Out bytes per second
')
Start Video redirection Fps: 20 In: 184 KB/s Out: 204 Bis i]
| =
Share I'\."IocieJ Monitor Mode
Figure 10-10
Start Video redirection

Message:

This section displays tool tip information and the video redirection status.

Fps: 20 In: 184 KBi= Out: 204 Bz

This section indicates the number of the frames displayed per second, and Input
(Kbytes per second)/ Output (bytes per second).

@ F
44 share Mode:

This icon indicates the status of screen-sharing on the remote system. If there is only

a
one user using the video redirection of a remote system, the icon will look like & | .If

two or more users using the video redirection of the same remote system, the icon

a a
will look like @4

37



Supermicro IPMIView User's Guide

i
= Monitor Mode:

O
This icon displays the status of monitor mode. When the display looks like , it

indicates that you can use the local keyboard and the mouse to control the remote

screen. When the display looks like % , it indicates that the local keyboard and the
mouse are not available. If you select the option “monitor only”, the keyboard and
mouse will be disabled.
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11. Virtual Media

The Supermicro Intelligent Management (SIM) Module provides a Virtual Media
feature, which includes a Virtual USB Floppy, a CD-ROM image and Drive

Redirection.

Figure 11-1 shows the Virtual Media GUI. The Virtual Media Status section displays

the current virtual device status. There are two virtual drives available.

Floppy Image Upload allows the user to upload a floppy image as "floppy" located at
the remote host. The floppy image uploaded shall be in the binary format with a
maximum size of 1.44MB. It will be loaded to the Supermicro SIM card and emulated

to the host as a USB device.

The CD-ROM Image on the “Windows Share” allows the user to configure Windows-
Share settings. It allows you to decide how you want to share the data stored in your

shared folder with the users on the remote host system.
Drive Redirection makes local drives accessible to other users via console redirection.

This function allows you to share your local drives (floppy, CD-ROM and HDDs) with

users on remote systems.
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(e 197 168.10.241

Virtual Media Statos
Drgive 1 Drpive 2
Tvpe : Floppor tmage Empty

Fead / Write mode: Wiitable
File name : floppy amg (1474560 bytes)

Floppyr Image Upload CD-EOM Image on Windows Share
Drive: |2 s =] Open ] [ Tpload Dirive: m w
Floppy lmage file: Share host:
C:Mloppyr img Bhare name:
Path to fimage:
Upload floppy tmage done ser (optional):

Password {ophonal):

Dirive Redirecton

Dirive 1: Mot connected

Dirive Redirection disconnected

Dirive 2:[  Connect Dirive H Connect IS0 [Not connected

Dirive Redirection disconnectsd

TR

Login | Event Log || Rensors | IFM Device | BMC Sethng || Uaers | Text Console | EVH Console | Virtal Medis

Figure 11-1

Floppy Image Upload

As shown in Figure 11-2, click <Open File> to select the file that you wish to upload to a
specific host drive of your choice. Click <Upload> to upload the floppy image. Please
wait for the uploading process to complete. The virtual floppy will be activated after the

floppy image is uploaded.
Floppy Image Upload

Dirive:
Floppy lenacge file:

Cfloppy drng

Uploading floppy image

[ ]

Figure 11-2
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CD-ROM Image on Windows Share

Please refer to Figure 11-3 for the following items.

Drive: Specify the drive that you want the remote host to share.

Share Host: Enter the IP Address or the name of the system you wish to share
data with via “Windows Share”.

Share Name: Enter the name of the shared data in the remote host.

Path to Image: Enter the location of the source file that you wish to share via
“Windows Share”.

User/Password (Optional): Enter the user and password for the person to
access the data that you want to share, and click the <Set> button to enter your

selections as shown in Figure 11-3.
CO-FEOM Image on Windows Share

Drive: 2w

Share host: 192 16310117
Share name: =0
Path to irmage: Co IS0

Uzer (optiohal):

Passward (optional):

Figure 11-3

Drive Redirection

As shown in Figure 11-4, Drive Redirection supports both local drive and the ISO file.

When you click the <Connect Drive>, a dialog will show up as figure 11-5.

Local Drive List: This box displays a list of local drives available for remote
access. Select from the list a local drive that you want to make accessible for a
remote server.

Refresh List: Click this button to refresh the local drive list.

Write Support: Check this button to allow the remote operating system to have
write access to the drive that you have selected. This function allows a user to
alter, overwrite, erase and destroy data stored in the drive selected. This feature
should only be used with non-critical data. Select the drive and click “OK” to start

direct redirection.
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The second type of drive redirection is “Connect ISO”. You may redirect the
ISO file directly from your file system. Click this button and select an 1SO file

to start this function.

Drive Redivection

Drivel:[ Connect Drive ” Commect [30 ]Notconneched

Cancelled Drive redivection

Dirive 2:[ Connect Drive ][ Commect [30 ]Notconneched

Dirive Redivection disconnected

Figure 11-4
:j Select a drive to redirect @

C: (Hard Disk) v [ Refresh List ]

[ ] Enable Write support

| 0K || Cancel |

Figure 11-5

Stop Active Drives
As shown in Figure 11-6, click <Stop Drive 1> to disable Drive 1 and Click “Stop Drive
2" to disable Drive 2. The <Refresh> button is used for refreshing the Virtual Media

settings. If you want to stop or change the type of a virtual drive, you first need to stop it.

[ @suopDrive! | [ @ StopDrve2 | [ Refesh
Figure 11-6
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12. Group Management

Group management is a way to manage multiple servers at the same time. For
example, you can query the fan sensor readings from multiple servers and note their
differences. Also, you can simultaneously power on or off multiple servers at the
same time. As shown in Figure 12-1, click <Manage Group> to show group
management. In group management, you can select multiple servers from the host
group on the left and manage them with the functions provided. You may re-arrange

groups of servers in the group list to make server group management easier.

07 [PMI Yiew ¥2.6.29 (build D70927) - Super Micro Compuier, Inc. (9 [=1E3]
File Edit Session o Help

A0 e 0de 26

j Group Management

SUPERMICR. FﬁanemperamIe Voltage  Sensors | EventLog | ACPI | Power LAN Config FRU | Text Console | General Info

i IPMIDomain & w O B & | ZZ
2 =00

Fan

System Name Ir Sensor Name Reading Unit Low Limit

[] Refresh every seonds

(et Virtual Media information done

Figure 12-1

In the group management, a Login ID and password are required. Click <Manage >
Setting to set the login information. Please note that IPMIView will use this account to
login to multiple servers. (Figure 12-2)

Gromp Login Sething gl

y Login ID ADMIN|
et [

save [ and Pagsword
* b dmindstrator level is required

Figure 12-2
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IPMIView provides various tools for group management. As shown in Figure 12-3,
group management can be grouped to the following categories.
. Fans
. Temperature
* Voltages
. Sensors
. Event Log
* ACPI
. Power
. LAN Configuration
* FRU
*  Text Console
*  General Information
Group Management
Fan | Tempersture | Yotage | Sensors | Event Log | ACP!| Powwer | LAM Config | FRU | Text Console | General Info

Figure 12-3

Fans

After you've selected multiple servers and clicked the <Fan> tab, a window will
display as shown in Figure 12-4. You can use <Ctrl+Click>, <Shift+Click> or draggin
your mouse to select servers. Click the <Query> button for IPMIView to collect the
fan readings from the selected servers. The information listed in the table shows the
fan status of the selected servers. If a fan reading is colored in red, the fan may be
broken, not installed, or the reading is below the lower limit. When this occurs, the
Administrator should take precautionary measures to ensure that the system

functions properly.
You may refresh the fan status by checking the Re-flash checkbox. IPMIView will

refresh the fan status based on a preset schedule. Please note that IPMIView will not

refresh if you switch to another tab.
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] IPMI View ¥2.6.20 (build 070927) - Super Micro Computer, Inc.

File Bdit Session Mansge Help

BE A 30 R

S C . =5 Group Management

UPERMICRS Fon | Tempesature | Voliaze | Sensous | EventLog | ACET | Power | LAN Config | FRU | Text Consnle | Genesal Info
Fan
Systern Nare i Sensor Name Resding Unit Low Limit
192.162.10.241 192.162.10.241 [Faul RPM ]
192.168.10.241 192.168.10.241 [Fau 47 RPM 600
192.168.10.241 192.168.10.241 [Fau? RPM 600
192.168.10.241 192.168.10.241 [Fand RPM ]
192.168.10.241 192.168.10.241 [Faus RPM 600
192.168.10.241 192.168.10.241 [Faufi RPM 600
193.168.10.341 192.168.10.341 Fan/CFUL RPM 600
193.168.10.341 192.168.10.341 FanB/CPU2 ] RPM 600
193.168.10.131 192.168.10.131 [Fanl RPM 600
192.168.10.131 192.168.10.131 [FauZ RPM 600
192.168.10.131 192.168.10.131 Fau? 4a0 RPM 600
192.168.10.131 192.168.10.131 [Faund RPM ]
192.168.10.131 192.168.10.131 [Feus RPM 600
192.168.10.131 192.168.10.151 [Feufs RPM ]
192.168.10.131 192.168.10.131 [FauTACP U1 RPM 600
192.168.10.131 192.168.10.151 [FanBiCPU2 RPM 600
TPMI Domsin (5/5)

FEeteenerey soonds Last updated 200710101 15:59:06 (16)

Finish

Figure 12-4

Temperatures

The screen shown in Figure 12-5 indicates that multiple servers have been selected,
and the Temperature tab is pressed. Clicking the <Query> button allows IPMIView to
collect the temperature readings from the selected servers. The information listed in

the table shows the temperature settings of the selected servers.

T IPMI View ¥2.6.20 (build N70927) - Super Micro Compuier, Tng.

File Edit Session Manage Help
tBa8o0e R ©
SUPERMICR® . *rour Henagement
Fan| Tempershure | Voltage | Sensors| EventLog  ACFPI | Power LAN Config | FRU | Text Console | Genersl Info
Tempersture
System Nams i3 Sensor Name Reading Unit High Limit
2] Lo L68.10.242 10216210241  [19216810241  CPU Temp1 50 degree C 750
[ 192.168.10.243 Tt : =5 - i -
168 102.168.10.241 10216810281 CFU Tempd 20 degree C 750
152,168 10 241 19216810241 CFU Temp 3 i degree C 750
152168 10241 19216810241 CFU Tempd I degrse C 750
192,168 10241 192 168 10241 s Temp Hi degree C 750
192,168 10.131 19216810131 CFU Tamp 1 21 degree C 750
192.168.10.131 10216810431 CPU Towmp 2 po degree C 750
192.168.10.131 192.168.10.131 s Temp hoo degree C 750
Groups Bé&dd
I8 1FMI Doein (5/5)
Flre — Jast updated 00741001 15:59:25 (8)
Finish

Figure 12-5
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Voltages

After selecting multiple servers and < Voltages> settings, you will see the display as
shown in Figure 12-6. Clicking the <Query> tab will allow IPMIView to collect the
voltage readings from the selected servers. The information listed in the table shows

the voltage status of the selected servers.

TTIRMI iew §26.29 (bl 070927) - Super Micow Compaser, Lo,
Fib Bdil Deson Musp Hilp

tHagde e
SUPERMICR@ T Sroue Management

Fua | Teesperstere| Volap  Semes | Eventlog| ACE | Puwer | LA Conlig] PRI | T Conmle | Smere lnde.

nE
Yot
Tyl [ Soxellae | Resding Tait Low Lt Tigh LinH
190168 10041 19306910341 12 el 108 161
168 1 341 1] m ] 16
1181031 i} Valt b i)
218010 i Fait aan S
21680 10, 1181 olr 1075 133
21801001 128 aii Hisz 101
03 160 10341 147 Tl tu 15
2 16010341 T Vel i 4n 540
10 168 10 741 3 ol T i)
10 6 10131 ol ] 61
E53.1£8 10, L3 it ] 16
UG8 103 i ] 263
S8R TLE Vel s LX)
D88 1015 i B[GE:] 334
LS T0.LE ol ] 549
LIS 10151 als s 380
5 Groups [T EE]
Mg 7 D 55)
[l Bsgmwary |60 | moonds Tt b 0NN 155027 {16)
Fusih

Figure 12-6

Sensors

After selecting multiple servers and clicking the <Sensors> tab, you will see the
window as shown in Figure 12-7. Click the <Query> button for IPMIView to collect the
sensor readings from the selected servers. The information listed in the table shows
the sensor status of the selected servers. The window here shows the chassis status
and power supply status. If the chassis is opened or a power supply has failed, the

reading will be in red.

TR View ¥2,6.29 (buill 070907} - Super Micns Compater, loc
T
BE e 826

s Group Management

SUPERMICR®

Fan | Tegentan | Yoluge| 2= | Byvail Log | ACH | Fower | LAH Coufig | FRU | Teid Conmle | Geaen ialo

N Bl
Ferews Sy sed Tabrusion,
ey T "
193 168.10343 A
1FE168,10341 193 168 10381
(LA AURE [ATCILEEY
TR0 AT ACEEY
Geups Bhae
PRl Docnaen (35
[ Bafobeh vty (60 | smesnl st pdaied 0001 15:59.32 §4)
Fuh

Figure 12-7
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Event log

After selecting multiple servers and clicking the <Event Log> tab, you will see a
display as shown in Figure 12-8. Click the <Query> button for IPMIView to collect the
event logs from the selected servers. The table below displays the event log of the

selected servers. Select the <Host combo> box to filter the event log data in the table.

M1 View ¥2.6.29 (build 070927) - Super Micro Computer, Inc.
Fle Edit Sesion Manage Help

CEIEY=TEIET

SUPERMICR®

Group Management

Fan | Tempersture | Voltage | Sensors| EventLoz | ACPI | Pover|| LAN Config| FRU | Texd Consols | General Info

v
T 192.168.10 i:g Time Stamp Type | Semsor  Event Tupe
. 09108007 14:32.09 Fri [Physical...Intrusion. |De-assertion: Physicel Security (Chossi Int &
9216510241 |19216610341  OS/1022007 [42402F  Fan  |Fans |Awertion Lower Nomoriticel - going low
(9216000241 [192.166.10041  DO/I0/007 [42402Fa  Fan  |FwnS |Asestion: Lower Criiel - going low
8216010241 |1921BG1041  [8/10/2007 142402Fn  [Fan  |FenS |Assention Lower Nonrecoversble - sning
3216000241 |192.166.10041  OO/I0/2007 [4:2402Fa  Fan |FantiC.. Asestion Lower Nomesiticel - going low
(5216810541 [102 16610241  De/I0/2007 142402 Fa  [Fan [FenTiC _|Assertion Lower Criial - going lowr
9216810241 |19216610241  Da/I0/2007 [49402Fd  Fan  |Fan?iC_|Awertion Lower Non-recoversbls - going
(5216810541 |102 1610341  DG/I0/007 [42402F  Fan  [Fowerd |Assertion: Lower Nomeriioal- going low
9216810241 |19216B1041  [a/10/2007 [49402F  Fan |PowerS. |Awertion Lower Criial - going v
(9216000241 [192.160.00041  DO/I0R007 [40402F  [Fan  [Powerd. [Awestion: Lower Nowrecoversble - eving
9216510241 |19216610341  OS/1022007 [42402F0  Fan PO G |Awertion Lower Nomorticel- going low
(9216000241 [192.166.10341  DO/I0/2007 [42402Fa  Fan  |CPUC.. |Asestion: Lower Criiel - going bow
8216010241 |1921BG1041  [8/10/2007 142402Fs  [Fan  |CPUC. |Assertion Lower Nonrecoversble - sning
3216000241 |192.166.10041  OO/I0/2007 [4:2402Fa  Fan | Therma. Asestion: Lower Nomesiticel - going low
(5216810541 [102 16610341  De/I0/2007 [42402F  [Fan |Thenma |Asserfion Lower Critieal - going lowr
19216810241 [19216B10241  [8/1072007 149402F  [Fan |Therma_|Asertion Lower Non-recoversbls - going
Groups B&sw 08:10/2007 W2402F0  Fem | Therms,. Asertion: Lower Nourerifeel - evtig low
TPMI Domain (515) 9216510241 |1921661041  [a/10/2007 (49402F  Fan |Therma_|Asertion Lower Criial - going b
19216010241 |09M0/2007 404 02F0  Fow |Theoms,. [Assection: Lowes Nowrecoversble - eoing
19216810241 090007 143434 Fri  Fom  |FanS |Assertion Lower Non-srifial - going low
19216610341 [192.160.00041  DO/IOE007 143434 Fa  [Fan  |Fans |Asestion: Lower Criiel - going low
‘192 16810341 19216610341  DBADMOO7 (43434 Fd  Fan  [FanS |Assection Lower Homrecoversble - aning
< >
[ Refeesh every — last updated 2007/10/01 16:01°48 (395)

Finish

Figure 12-8

ACPI

After selecting multiple servers and clicking the <ACPI> tab, you will see a display as
shown in Figure 12-9. Click the “Query” button for IPMIView to collect the ACPI state

from the selected servers. The table displays the ACPI state of the selected servers.

O IPMI View ¥2.6.20 (build 070027) - Super Micro Compuer, Inc
File Edit Sewsion Msage Help

bmagie e

= :
. " Group Management

| IPE =

SUI ]-'R'Ml(' R. Fam | Tempaostue | Voltags | Sensors | Event Log| ACH | Fower | LAN Condiy | FRU | Text Comule | Geoesal lufi

A~02% = QM

ACH
Syystem Namme ]

192,166 10.241 20100 working

ACHISme  Dexrpion  OndOtf
19216800242
L 152 150.10.243 192.168.10 241

192.168.10.131 19218810131 =010 workimg

Groups. BEAae

1PM] Domain (575)

[ Refmshevery |60 o seomds last upedated 200710401 160205 ()

Firushy

Figure 12-9
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Power

After selecting multiple servers and clicking the <Power> tab, you will see a display
as shown in Figure 12-10. Click one of the power <Control> buttons to send a

command to the selected server. The text area will show the result.

T APMI Faew Y2,6.09 (buid OT0UIT) - Swper Miero Comgnter, Ine,
Fib B3 Sesmn Mg Help

nE AN RO
SUPERMICR@ % 5roup Mansgemert

Fan | Tempensters | Yoliage | Sercors | FventLog | ACH | Powss | LAN Condig| PRI Ted Console | Genersd Info

PMDeman & w O B &) | Omeetel Power Contel

Bl 12 164 10131
o

[ macen | [ | [ OomeeniRetont | [ Gomcet Bowes ek |

Chamis Power Coatrol

[ Powsslown | [ FowerOp | [ TowsCrk [ Bemt |
Rt
200710001 16:02:42] Sending Powss Up 1o 192.168.10.241... OK
(20071001 16:02:42) Sending Power Up to 192, 165.10.243._ 0K

= Groups EEE]
PN Do, (45)

Figure 12-10

LAN Configuration

After selecting a single server and clicking the <LAN Config> tab, you will see a
display as shown in Figure 12-11. Click <Query> to get the information needed from
a single server and copy it to other servers for data-sharing. The text area will show
the results of the query and provide updates. The <Clear> button is used to clear the

text field only; it will not clear the actual LAN configuration from the server.

7 [PMI View ¥2.6.29 (build 070927) - Super Miczo Computer, Inc.

0O & ane e

.:.ﬁ, Group Management

SUPERMICR‘ Fin | Tempentire | Volnge | Semors | Eventlog| ACH | Power| LAN Coulig | FRY | Tt Console | Genersl Info
IPMiDomain & w & £ 4 | LAN Conhgumbon
192168 10151 Gty 17 197168 10 254 Gt
192.160.10.340 MAC,  G0R0R0P00000 (|

10,168, 10.242 SebelMask | 255252550 (=

- .
[ 19210810203 P ——

Community  public

L 1921681043 | MAC | 000000000000 T

2P 0000 | 2Mac| MDD [ Opdee |

LT 1MAC| NN [_char
Ranct

[20070/001 180311 Gelting LAM Conhgraton frorm 19216310241, 0K
Gateway 1P = 192 168 10 754

Cabimwany MAC = 0000 00 00 00 00

Subnet Mask = 255.255.255.0

[2007,10/01 16:03:12] Getting SNMP Configration from 192.160.10.241... Ok
ESMMP Destinstion 1 = 192.168.10.43 (00:00:00:00:00:00 )

Ganps B & & % | SNMP Destination 2 =0.00.0 ( 00:00:00:00:00,00 )
IPMI Domain (55) SMNMF Destngtion 3 = 0.0,0.0 ( 00000:00:00:00:00 )
Fuush

Figure 12-11
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FRU

After selecting a single server and clicking the <FRU> tab, you will see a display as
shown in Figure 12-12. Click the <Query> button for IPMIView to get the FRU
information from a single server, and copy it to other servers for data-sharing. The
text area will show the results of a query and provide updates. The <clear> button is

used to clear the text field only; it will not clear the actual FRU data from the server.

DT IPMI View ¥2.6.29 (buiM 070927} - Super Micm Congater, Tnc.

Fie Ble Demon Mg Hep
BEa QEd 26
:{g Group Management
SUPERM]CR‘ Fa | Tecgaratune | Voliage | Seasors| Eventlog| ACP1| Fowss| LAN Coafig| FRO | Tud Conscle | Génenl Endis
PMIComan A w @ 8 @ | P

152 160.10.130 ERET Clear
| 192 168 10 340 l—k_ ,,l‘—f JCucd Product I

Masudans Sxper Micm
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192160 10242 ke
197 168 10 243 L ol i

PutMusber | AGC-IMEN-E Toeicn
Zarml Nember

Bt
200770001 16.03 41] Gelting FRU from 192 168 10.241 . 0K

Geoups. Bdde
-
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Figure 12-12

Text Console

After selecting a single server and clicking the <Text Console> tab, you will
see a display as shown in Figure 12-13. Click the <Open> button for IPMIView
to create an internal text console window for the selected server. Click <Start>
to start the text console redirection. The power control buttons displayed on
the status bar provides power on, power off and reset commands, allowing
you to easily power on or power off a remote server. The <Encode> checkbox
is for RMCP+ encoding. Check it to enable packet encoding between the

IPMIView and a server.
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General

I IPMI View ¥2.6.20 (build 070327) - Super Miczo Computer, Inc.
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Figure 12-13

Information

After selecting multiple servers and clicking the <General Info> tab, you will see a

display as shown in Figure 12-14. Select the fields you want to query from the

servers, and click the <Query> button to allow IPMIView to collect the information

from the selected servers.

7 TPMT View ¥2 629 (build D70927) - Super Mico Compuier, Inc_
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Figure 12-14
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13. Trap Recelver

The Trap Receiver is a utility used for receiving traps from the BMC. In the event of a

sensor error or a sensor reading that exceeds a threshold, the BMC will send SNMP

traps to the destinations set in the BMC. The Trap Receiver is executed on the

destination site and receives the SNMP trap from multiple senders (BMCs). If you

select a category, you can see all the traps in that category. Furthermore, when you

click a trap in the trap list, you can see its details in the <Trap Structure> window.

Please refer to the BMC Setting page in IPMIView to set the SNMP destination.

As shown in Figure 12-1, there are several components to the IPMI Trap Receiver.

* Menu Bar: contains pull-down menus for exiting the programs, getting help, etc.

* Tool Bar: contains all IPMI Trap Receiver features.

* Category: categorizes the traps by the sender, community and sensor.

e Trap Structure: It is a tree structure that displays traps in detail.

* Status Bar: shows messages regarding the current status of related

components.

* Trap List: shows detailed information for traps received.

A TPMI Trap Receiver V2.0 (huild 051122) - Super Micio Computer, Tnc
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# Specific Trap Type: 262400 22 19216810245 [puklic crU1 Uppeer M - high 2005001 154350 ..,
& Timelicks 1128180277 yal 18216010245  |puklic FANZ Lcrwer Mon-criical - going koo 20054 0 1550007
= ] POU Booy 24 19216810245  |puklic FAM 2 Lirwrer Crilical - going low 20054 040 1550008 ...
#® Total Length of Variable Bk 25 19216510245  |public FAN 2 Lirwer Nonrecoveralie - guirg low 200510001 1550010,
= B 26 19215510245  |putlc FAME  Lower boncriicsl - going low 20051011 155022
® Lengthof Bnding 70 ™| (27 192163.10245 |public  FANG |Lower Criical- going low 20051001 1550:23 ... | ¥
£ Sender = 192168 10245 | Commwindy = * | Sensor = *

Status Bar —|

L2 Trap Received Sender P =132 .160.10.247, contert = [ CPU1 JUpper Mon-recoverable - gaing high

Figure 12-1

— Trap List
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Tool Bar functions

The tool bar provides the following features as shown in Figure 12-2.

> @ O a m 3

Stop Save Load Clesar Etmail

Figure 12-2

» Start: starts the Trap Receiver.

e Stop: stops the Trap Receiver.

* Save: saves the traps received into a file.

* Load: loads a saved trap file into the Trap Receiver.

* Clear: clears all the traps in the trap list.

* Email: displays an “Email-Alert Settings” dialog box (see Figure 12-3). Fill the
“SMTP server”, “From (email address)” and “To (email address)” fields. The
“From” and “To” addresses must be valid in the SMTP server. If the SMTP
server requires authentication, please enter the username and password.
Once entering needed information, click the <Test> button to verify if your
email works properly.

Email Alert 3

Email Alert Setting

[] Enable Email Alert

SMTP Server:
From:

Ta:

[ Authentication
Lzername:
Pazsword:
Figure 12-3

Category

There are three categories including: Sender, Community and Sensor as shown in
Figure 12-4. The Sender page lists all sender IP addresses. The Community page
lists all SNMP communities. The Sensor page lists all sensor types from the traps.
Clicking on each category type will act as a filter for all traps in the traps list. Click the

<All> button to cancel all filters.
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Category All

af
# 19216510245
# 19216510247

Category All

&

# public

Sender | Community | Senzar

Category All

Sender | Community | SEnsor

2
# FANM4
Fam 3
Fam 2
CPL
Fam 1
FaM 5
FAM G
FamM 7
FAM &
Irtruzion

LK R R R R R

Sender || Community | Sensor

Figure 12-4

Once a category has been selected, the filter condition will be displayed at the

bottom of the “trap” list. See Figure 12-5 for reference. As displayed in Figure 12-5,
the filter is “Sender = 192.168.10.245, Community = public, Sensor = CPU 1". The
trap list displays only those traps whose contents are included in each of the three

filters.
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Trap Structure

The Trap Structure displays detailed information for the selected item in the trap list.

Rum Sender Cornmunity Sensar Description LocalTimeStamp

10 19216810245 |public CPI A Upper Mon-critical - going high  |20054 0001 15:46:22..
11 192.165.10.243  |public CPI A Upper Man-critical - going high  |[20024 0401 1:5:46:25..
12 192168.10.245  |public CPLUA Upper Critical - going high 20051 0/01 15:46:26...
13 19216510245  |public CPI A Upper Mon-recoverahle - gaoi... [20054 0001 15:46:26..
20 19216510245 |public CPL A Upper Mon-critical - going high  |[20054 0001 15:49:49..
21 192168.10.245  |public CPLU A Upper Critical - aoing high 20051 0/01 15:49:50...
22 192.165.10.243  |public CPI A Upper Mon-recoverable - goi... (200240001 1:5:49:30...

Sender = 192 168 10.245 | Community = public | Sensor = CPU 1

Figure 12-5

Information includes the “SNMP Header”, “PDU Header”, “PDU Body”, “Bind” and “PET"

data.

Trap Structure

] SNMP Trap
= | ] SMMP Header

# hessage Length: 125

# hMessage Version: vl

& Community: public

=l || PDU Header
Type: Trap
length: 109
Erterprize: 1.36.1.4.1.31583.141
Agent IP: 192.165.10.245
Generic Trap Type: B
Specific Trap Type: 262400
Timeticks : 11261580281
=l || POU Eady
# Total Length of Yariable Binding: 72
= ]Eind
# Length of Binding: 70
# Ol 1361413183112
= [ ] PET Data
# [FAM 3] Lower Mon-critical - going low
B " O0RE]" (@[ 2xTF] @ S0 O

LB B R R B

Figure 12-6
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Receiving a Trap

When the Trap Receiver receives a trap from the BMC, an alert bar will display on

the screen for about 10 seconds to notify you that a trap has occurred. In addition, an

email alert will be sent according to the information field in the Email Alert dialog box.

Please refer to Figure 12-7.

The email will include the following information.
A SNMP trap received

Sender:192.168.10.247

Sensor:FAN 2

Description:Lower Non-recoverable - going low
Time:2005/11/22 14:27:07 Tue

#F IPHMI Trap Receiver ¥2.0 (bunild 051122} - Super Micro Computer, Inc_

Fil: Help

> @ [E

&a m =

A Trap Received: Sender IP =192165.10 247 content = [ FARN 2 JLower Critical - going low

Stop Save Load Clear Email
Category a1 um Sener Cmun'rt\,f Sensor Description LocalTimeStamp
A =N LB u ~
‘J 2 192.1658.10.... |public Far 4 Lovwer Critical - going low 20050 0 15:24;
# 19216510245 3 192165810, |public Far 4 Lowwer Mon-recoverable - gai... (2005010001 15:24:4.
# 19216510247 4 192.1658.10.... |public Fam 3 Lovwer Mon-critical - going low (2005010001 15:24:4..,
a AODALRAD edilis Akt mreme Soltisa by oy 20050 0001 15:24:4.
A Trap Received rable - goi... (2005010001 15:24:4,.,
. Sender 19216810247 - gaing lowe (20050 0001 15:46:1 ..
Sender | Community | Sensor “% Content [FAN 2] Lower Critical - going low nglove 2005001 15:461.,
rable - goi... (200500001 15:46:1...
Trap Structure T T9Z. 100, TU.... [T RO OEpEr MOrFCTeET - going high 200504 0001 15:46:2..
;| SMMP Trap ~ |11 192.165.10.... |public CPU Upper Mon-critical - going high | 20050 0001 15462
= _| ShP Header 12 192.1658.10.... |public P Upper Critical - going high 200501 0 15462,
# Messzage Length: 125 13 19216510, |public CPL A Upper Mon-recoverable - goin... | 20054 0001 15:46:2.
# Message “Yersion: wi 14 192.1658.10.... |public Fam 3 Lovwer Mon-critical - going low (2005010001 15:49:2...
& Comrmunity: public 15 192165.10.... |public FAN 3 Lowver Critical - going low 20054 0001 15:49:2.
= _| POU Header 16 192.1658.10.... |public Fam 3 Lovwer Mon-recoverable - goi... (2005010001 15:49:2...
# Type Trap 17 192165.10.... |public FAN 4 Laovwver Mon-critical - going low (20054 0001 15:49:2.
# length: 109 18 192.1658.10.... |public Fam 4 Lowver Critical - going law 20050 0 15:49:3..,
# Erterprize: 1.361.41 31 19 19216510, |public Far 4 Lowver Mon-recoverable - goi .. (20050 0001 15:49:3 .
# Agent P 19216510245 20 192.1658.10.... |public P Upper Mon-critical - going high | 20050 0001 15:49:4,
# Generic Trap Type: 6 21 182 165.10.... |public CPU Upper Critical - going high 200510001 15:49:5.
# Specific Trap Type: 2624 22 192.168.10.... |public CPUA Upper Mon-recoverable - aain... | 2005010001 153048903,
& Timeticks : 1128180277 23 182 165.10.... |public FAM 2 Lowver Mon-critical - going low  |2005M 0401 15:50:0..
= _| POU Eody 24 192.1658.10.... |public Fam 2 Lowver Critical - going law 20050 0 15:50:0...
? Tatal Length of Wariable 3 25 19216510, |public Fam 2 Lowver Mon-recoverable - goi .. |2005M 0001 15:50:1 .
< ﬁl e > . Sender = * | Community = * | Sensor = *

Sending Email ...

Figure 12-7
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Appendix A: SIM Firmware Update

1. Select a remote system on the System list and click “File > Update IPMI Firmware”

to start the firmware update.

Edit Session Manage
Hew... b
Discover IFMT Device

Reload Configuration
Have Configuration

pdate IFMI Fionwsare

Langnage b
Exit

Figure A-1

2. Click the <Open> button to select the<firmware> you desire and then click <Start>

:j Tpdate Firmware E]

IP: 192.168.10.24%

to continue.

Firrmweare File; | | [ Open H Start ]

Meszage:

Figure A-2

3. A login dialog will appear. Please enter the Login_ID and the password. This user

will be granted the privilege as an Administrator.

56



Supermicro IPMIView User's Guide

Please anput I and Passwornd [5_(|
Login ID | ADMIN |
Pazsword Ak

* Administrataor level is reqguired

| OK | [ Cancel |

Figure A-3

4. A firmware information dialog will appear. It shows detailed information on the
current and new firmware. Click <Yes> to continue.

Request Confimmation fg|

Curresit firmeweare:
Firmware Version: 1.5.0 build 4238

Firmware Tag: Aug-14-08-17-30
harduare 1D O0x22
OEM: peppercon

Wew finmuware:

Firmware Version: 1.5.2 build 4238
Firmware Tag: Aug-16-08-11-10
Firmware Size: 3092376 bytes

Firmyware Path: C:\w-kira-kimsmigd-smide-peppercon_040200-4238-081606-1-5-2.bin
Tould you like fo continue 7
Figure A-4

5. The firmware file will start to upload. This process may take few minutes to
complete.

:j Opdate Firmware E

IP: 192.168.10.249

zrcon_040200-42358-051 606-1-5-2 hin |

Firruvare File:

Uploading firrmwware

L LLLLL]L] ]

Message:

Login to 192.1A5.10 249
tart firmware upgarde

Mploading firmware ...

Figure A-5
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6. Please wait for the firmware to upload. Once uploading is completed, the BMC wiill
start to flash the firmware internally. This step may take about a minute. Please try to

connect to the system after two minutes.
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Appendix B: SIM(W) KVM Console

and Virtual Media

SIM(W) KVM Console allows the user to perform console redirection via KVM

(Keyboard/Video/Mouse) support as shown in Figure B-1.

s

T IPHI Yiew ¥2.7.13 (build 100504) - Saper Micro Computer, Inc.
File Edit Sesdon Manage Help

Bl a8 e e

S { g 19216812 169
UPERMICR® @® @ @IFUHScreen =] Vistoal Media [B] Soft Keybosud stpe e
IPMI Domain A v Q& @,

~

13 12 | Fanl 675.00 RPM
192.168.12.171
172.31.2.154 14 13 | Fan2 ©.00 RPM

i i
i i
15 i 14 i Fan3 0.00 RPM
i i P53 Status 0K [00 CO 00 001

16 1?7

o] 172.31.2.123 C:N>ipmicfg —-sdr »aa
o] 172.31.2.145 ] an
172.312 146 :

% 172.31 162 Sensor Sensor Reading
@1?2'31'2'31 CPUZ Temp nsa [00 EO @7 001
] 17221250 3ystem Temp 36.00 degree C
’r:jm'sfz'sg CPU1 Ucore 1.12
’f:jil?zjléﬁz CPUZ Vcore 0.00
o 172,312,181 +12U 11.31
& 1972.168.10.118 +3.3V 3.23
21 192.168.10.99 DIMM 1.81
& 192.168.10.30 +5U 5.06
& 197.168.10.50 +3 .3USHE 3.23
L v UBAT 3.23
Groups E & & ) E::; 573,33

. Fan3 0:00

Hew Groupl (20100

Hew Croup? (20T PS5 3tatus 0K [00 CO 00 001

o (048
Mew Gronp? (322)

Redirection Viewerstarted

Login | Event Log | Sensors| [PM Device | BMC Setting | Users | Text Console | KV Console

REMCP+ Open Sessdon suecessful

Figure B-1 SIM(W) KVM Console Main Screen
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SIM(W) Console Toolbar

The SIM(W) Console Toolbar provides seven tool buttons which will allow the user to

perform the following actions as shown in Figure B-2.
Start Video Redirection
Stop Video Redirection

Screenshot
Refresh (the page)
Full Screen (display)

|
2y Q‘ Full Screen [ Vistual Media Soft Kleybnard Ltps [ Menu
‘ |

Soft Keyboard (to use the soft keyboard) Menu
Virtual Media (to use Virtual Media)

Figure B-2 SIM(W) KVM Console Toolbar

I} Start Video Redirection:
Click this button to start SIM(W) KVM console redirection.

@ Stop Video Redirection:
Click this button to stop video redirection. Please note that the drive redirection will

continue to work when it is enabled.

QI Full Screen:

Click this button to maximize the size of the remote video screen displayed on the

local computer screen as shown in Figure B-3.

Figure B-3 Full Screen

60



Supermicro IPMIView User's Guide

Virtual Media:

Click this button to enable Virtual Media support as shown in Figure B-4.
“4 Virtual Media X

FloppwTT3E Eew Media

© Hisgy T Brove | | ComeetFomy |

CD Media

@ 150 Image [ Brows ] [ ComectcDmYD
OE
OF

Status

Target Drive Connected To Read Butes

Virtual Floppy Mot connected na
Virtual CD Mot connected A

Cloz=

Figure B-4 Virtual Media

* Floppy/USB key Media: This feature allows the user to redirect Floppy/USB
Media.

* CD Media: This feature allows the user to redirect CD/DVD or ISO image file.

* Connect Floppy: Click this button to start to redirect your Floppy Image or USB
Key Media.

* Connect CD/DVD: Click this button to start to redirect your CD/DVD or ISO

image file.

&l 5oft Keyboard:
Click this button to use the Soft Keyboard for console redirection as shown in Figure
B-5.
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Combination (of Keys) Lock (Hold Modifier Key)

Soft Kevboard v .96

Langnage Modlifier EewCtel, Alt, Shift, Win, [PriSc)
IE Jish(United Stotes) 3 | () Combination | ] Lock
O Single Key
ERC F1 |F2 |F2 |F4 | FE5 |Fa |F? (F8 | F9 |F10{F11|F12 P |SexllPan
1 |2 2l 4 ] 5l 5 7 ] ] [ ] - ] BR Ins |Hon PR Nug/ |*

Tab ool «2a e S v | ] 1S 1 o ] | [ 1] Del |End{PDx Hon & |PUR
Capiil =l =l d ol £l ol bl 1l ol 1 | - -+ - = |4
whift Z A A - Ty S - ] Bhift it End| § |PDu
Chl | Win&lt Alt | Win AppCtil o= ) e Ins Del |«

Figure B-5 Soft Keyboard

* Language: This feature allows you to select a proper language setting for your
soft keyboard.

* Combination: Check this button if you want to use a combinations of modifier
keys

* Single Key: Check this button if you want to use a modifier key as single key.

* Lock: Check this button to hold the modifier key you've clicked.

The menu is same as web KVM UI.
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Appendix C: SIM(WA) IKVM

Console and Virtual Media

onsole> to open SIM(WA) iKVM Window as in Figure C-1.

Press <Launch KVM C

__t IPMI ¥iew ¥2 7 13 (build 100504) - Super Micro Computer, Inc.

File Edit Sessdon Manage Help

e e gde

5 ©

EEX

SUPERMICR®

IPMI Domain = + J £ &
.

& 192.168.10.30
& 192.168.10.50
& 17231217
& 172.31 2161

& 192160.12.160| ® 192.168.12.125

Consols Redirection

Lannch K¥M Console

B Press the button 1o launch the redirection console and manage the server remotely.

| Login || Event Log || Sensors || IPM Device || BMC Setl:ing” Users" Text Comsole | KV Console!

RMCP+ Open Sessdon successful

Figure C-1 SIM(WA) iKVM Window
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Please note that SIM(WA) iKVM window supports same features as other versions of
Web KVM as shown in Figure C-2.

Java iKYM Viewer v1.55 r7 [102.168.12.125] - Resolution 652 X 492 - FPS 0
Wirtual M‘ Record  Playback  Macro  Options  UserList  Exit

. Press any key to enter the menu

Booting Cent0S (2.6.18-164.€15) in 3 seconds. . .[Jj

Figure C-2 iKVM Window

Virtual Media (USB Floppy & Flash)

Click <Virtual Media> on the menu bar and then click <Virtual Storage> to display the
Virtual Media (USB Floppy & Flash screen) as shown in Figure C-3.

Yirtual Media 1.2 12

USEIFloppy =TT
Setting for Device 1
Logical Drive Type Image Filename and Full Path
|I'Io Select v | | |
=T
Connection Status History
A
b
< >

Figure C-3 Virtual Media (USB Floppy & Flash)
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* Logical Drive Type: From the pull-down menu select the logical drive type.

* Image Filename and Full Path: Enter the image file name and the full path to
the file. It is available only for ISO files.

* Refresh: Click this button to refresh the page.

* Plug In: Click this button to mount your logical drive as virtual media.

* Plug Out: Click this button to un-mount virtual media.

* OK: Click this button to confirm and exit.

* Connection Status History: This window displays the connection and the status

of virtual media.

Virtual Media (CDROM & 1SO)
Click < CDROM & ISO > to display the Virtual Media (CDROM & ISO). as shown in
Figure C-4.

Yirtual Media 1.2 12

Setting for Device 2
Logical Drive Type Image Filename and Foll Path
o Zelect “
= T
Connection Status History
-~
-
< >

Figure C-4 Virtual Media (CDROM & 1SO)

* Logical Drive Type: From the pull-down menu select the logical drive type.

* Image Filename and Full Path: Enter the image file name and the full path to
the ISO file.

* Refresh: Click this button to refresh the page.

* Plug In: Click this button to mount your logical drive as virtual media.

* Plug Out: Click this button to un-mount virtual media.

* OK: Click this button to confirm and exit.

e Connection Status History: This window displays the connection and the status
of Virtual Media.
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iKVM Virtual Keyboard

Virtual Keyboard provides soft keyboard support and allows the user to click a key on

the soft keyboard by using the mouse when a keyboard is not available. Refer to
Figure C-5 for Virtual Keyboard.

Englizh keyboard Z||:|[$_<|

esc| |F1|F2({F3|F4| |F5|F6|FT7(F5| |F9|F10/F11|F12
415167890 (- |=]| = |[ins|"| L |mk|/|*

¥lc|v|b|n|m|,|. |/ iy T “*.iT*I
2| alt at |# |8 ol |[<] 4 ||| ins fder

2 2o =

Figure C-5 Virtual Keyboard
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Appendix D: SIM(W) Firmware
Update

To re-flash SIM(W) Firmware, please select an SIM(W) device and <Update
firmware> in the menu. Then, click <OK>. A dialog box will display as shown in
Figure D-1.

Confirmation

1 ) Thiz iz SIM (W device. Please make sure yon have comect firmware for update (% ima)

0K || Comeel |

Figure D-1 SIM(W) Firmware Re-flash

YAFU Flash

1. To flash Hermon Firmware, The YAFU Flash Main screen will display as shown in
Figure D-2.

Y AFTIFlash b_q
Remote Flash Tool for Hermon/AM FUW V131
IE: |192.168.12.169 | Options
[ ] Presrve Bootloader
File: | | [ Browse. . ]
[ ] Preserve Config Module

Figure D-2 YAFU Flash Main screen
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2. After you've selected a firmware file for remote flashing, it will be checked if it is a

valid file before remote flashing starts.

Y AFTIFlazh E'
Remote Flash Tool for Hermon/AM FUW V121
IP: |192.15=3.12.159 | Options
[ ] Preserve BootLoader

Fil:: DAFWAMAMINIDCT-L 130ima | | Erows. ]

[ ] Presrve Confiz Maodule
e fimmware wersdon ; 1.30

Figure D-3 YAFU Flash (2)

e |P: This item displays the IP Address of the IPMI device.

* Browse: Enter the file name or browse the data base to select a file that you
want to perform remote flashing.

* Preserve BootLoader: Check this box to preserve the settings of BootLoader.

* Preserve Config Module: Check this box to preserve the settings of
Configuration Module.

* Firmware Version: The new firmware version will be displayed.

* Flash: Click <Flash> to commit the file for remote flashing.

3. Remote Flashing can only be performed by an Administrator. If you are an
administrator, enter your ID and your password in the screen below. Then click
<OK>,

Flease input I and Fassword f$__<|
9 ) LoginlD | |
R-?/ Pagsword | |
* b dyndndstrator level iz reqguived
| ok || Come |

Figure D-4 ID and Password (Administrator)
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4. Check the current firmware version. The current firmware version will be displayed

as shown in Figure D-5.

Y AFUFlash [z|
Remote Flash Tool for Hermon/an FWW V121
IP: [192.168.12169 | Ciptions
[ ] Preserve BootLoader
File: |D:'-.FW'-AMI‘-.K".-‘DCT-L_13EI.:'ma | [ Browse... ]
[ ] Presrve Confiz Maodule

e fimmware wersdon ; 1.30

Crret fivmeware wersion: 1.30

Figure D-5 Display of Current Firmware Version

5. Once you've checked the firmware versions and clicked <Flash>, YAFUFlash

remote flashing will start as shown in the screens below.

Y AFUFlash X

Remote Flash Tool for Hermon/AM FUW TFi1i1

P [192168.12.169 | Cptions

File: |D:".FW"LAMI".K?DC T-L_130.4ma |

Wew frrmware verson ; 1.30

Current firmware version: 1.30

atatus: 79 (1,310,720 bytes £ 16,777,216 baes )

Remaining Time: 6 minfz) 47 seis)

Figure D-6 Remote Flash Screen #1
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Y AFUFlash [-5—<|
Remote Flash Tool for Hermon/AM FW V121
IF: |192.168.12.169 | Options

Frezerve Bootl.oader

File: |D:".F1.?'.T".AMI".K'.-‘DCT-L_13EI.m| Browse...

Frezerve Confiz Module
Wew firmware version : 1.30
Crrrent firmeware version: 1,30 FW ¥ersion
Status: 22% (3,801,088 bertes / 16,777,216 botes )
BERERERRERRR
Femaining Time: 5 minlz) 41 zeciz) Flazh

Figure D-7 Remote Flash Screen #2

Y AFlIFlash &|
Remote Flash Tool for Hermon/AM FVW V121
IF: |192.168.12.169 | Optinns

Preserve Bootloader

File: |D:~meM1th:T-L_1sn.m| Browse..

Prezerve Config Module
Wew firmyeare version : 1.30
Crret firmmyeare version: 1.30 F¥ ¥ersion
Statuz: 51% (8,585,216 botes £ 16,777,216 botes )
CLELLLEEE R L b L]
Rematning Time: 3 min(z) 35 ez Flash

Figure D-8 Remote Flash Screen #3
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Y AFTFlazh

Remote Flash Tool for Hermon/AM FW

IP: (19216812169 | Options

File: |D:".F1.?'.T".AMI".K'.-‘DCT-L_13EI.m| Browse...

Mew fiomeware wersion ; 1.30

Current firmeware verson: 1.30 FW Version

Status: Findshed . (BMC needs 1 minute 1o restart)

W12l

Frezerve Bootl.oader

Frezerve Confiz Module

IIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIII]

Figure D-9 Remote Flash Screen #4
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Appendix E: SIM(WA) Firmware
Update

1. Select an SIM(WA) device and select <Update Firmware> in the menu for SIM(WA)
Firmware Re-flashing. A screen will display as shown in Figure E-1.

Confirmation

- | ) Thiz i SIM{WAY device. Please malke sure you have cormect ficmware for vpdate (% bin)

0K || Comcel |

Figure E-1 Firmware Update Screen

2. Make sure that you've selected the correct firmware for update, and click <OK>.
The Main Flash Screen will display as shown in Figure E-2.

Flaszh Tool E'

Remote Flash Tool for Hermon/AT FW V120

IF: |192.168.12.125

Browse. .

]

File: |

FI Yersion

Figure E-2 Main Flash Screen
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3. After you've selected a firmware file for remote flashing, it will be checked if it is a

valid file before remote flashing start.

Flash Tool [$_<|

Remote Flash Tool for Hermon/AT FW V120

IF: |192.15=3.12.125 |

File: |D:FWATEN&EDTL 817 bin |

Wew fimware wersion ; 01.15

Figure E-3 Main Flash Screen

4. Remote Flashing can only be performed by an administrator. If you are an
administrator, enter your ID and your password in the screen below. Then click
<OK>.

Please input ID and Password b__(|
9 ) LoginID | |
</
Paszueond | |
¥ dnindstrator lewel is required
| ok || Comel |

Figure E-4 ID/Password Screen
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5. Check new and current firmware versions. The firmware versions will be displayed

as shown in Figure E-5.

Flash Tool [$_<|

Remote Flash Tool for Hermon/AT FW V120

IF: |192.15=3.12.125 |

File: |D:~meTEMEDTL_s1?.hm | | Browss.

Wew fimware wersion ; 01.15

Crrreit fivmeware werson: 0110

Figure E-5 Firmware Versions

6. Once you've checked the firmware versions and clicked <Flash>, firmware flashing

will start as shown in the screens below.

Flaszh Tool rs_(|

Remote Flash Tool for Hermon/AT FW V120

IF: |192.1r53.12.125 |

File: |D:~meTEHu{aDTL_31?.hm | Browss,

Wew firmware version ; 01.15

Crrrent firmware werson: 01.10 FI ¥ersion

Statnz: Uploading...

0%

Figure E-6 Remote Flash Screen #1
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Flash Tool

Remote Flash Tool for Hermon/AT FW Y120
Ip: |192.168.12.125
File: |D:'-.FW'-£ TEMEDTL 817 bin Browse...
Wew fimware wersion ; 01.15
Crrreit fivmeware werson: 0110 FIT Werson
Statnz Updating...
- T

Flazh

Figure E-7 Remote Flash Screen #2

Flash Tool

Remote Flash Tool for Hermon/AT FW

IF: |192.15=3.12.125

File: |D:".FW"JL TENYEDTL 817 bin

Wew fimware wersion ; 01.15

Crrreit fivmeware werson: 0110

Statns: Updating...

X

¥1.2.0

Boovwse. .

FIT Werson

Figure E-8 Remote Flash Screen #3
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Flash Tool

Remote Flash Tool for Hermon/AT FW

IF: |192.168.12.125

File: |D:".FW".P; TEMGEDTL 817 bin

Wew fimware wersion ; 01.15

Crrreit fivmeware werson: 0110

Status: Findshed

100%

¥1.2.0

Boovarse.

FIT Werson

Cloze

Figure E-9 Remote Flash Screen #4
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Contacting Supermicro

Headquarters

Address: Super Micro Computer, Inc.

980 Rock Ave.

San Jose, CA 95131 U.S.A.

Tel: +1 (408) 503-8000

Fax: +1 (408) 503-8008

Email: marketing@supermicro.com (General Information)
support@supermicro.com (Technical Support)

Web Site: www.supermicro.com

Europe

Address: Super Micro Computer B.V.

Het Sterrenbeeld 28, 5215 ML

's-Hertogenbosch, The Netherlands

Tel: +31 (0) 73-6400390

Fax: +31 (0) 73-6416525

Email: sales@supermicro.nl (General Information)
support@supermicro.nl (Technical Support)

rma@supermicro.nl (Customer Support)

Asia-Pacific

Address: Super Micro Computer, Inc.
4F, No. 232-1, Liancheng Rd.,
Chung-Ho Dist., New Taipei City 235,
Taiwan, R.O.C.

Tel: +886-(2) 8226-3990

Fax: +886-(2) 8226-3991

Web Site: www.supermicro.com.tw
Technical Support:

Email: support@supermicro.com.tw


http://www.supermicro.com/
mailto:support@supermicro.com.tw
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